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Preface  

This book is designed to introduce users of STATGRAPHICS Centurion XVII to the basic operation 
of the program and its use in analyzing data. It provides a comprehensive overview of the system, 
including installation, data management, creating statistical analyses, and printing and publishing 
results. Since the book is intended to get users up to speed quickly, it concentrates on the most 
important features of the program, rather than trying to cover every detail. The Help menu within 
STATGRAPHICS Centurion XVII gives access to an extensive amount of additional information, 
including a separate PDF file for each of the approximately 220 statistical procedures. 

The first nine chapters of this book cover basic use of the program. While you could probably figure 
out much of this material on your own while using the program, thorough reading of those chapters 
will help you get up to speed quickly and ensure that you donõt miss any important features.  

The last eight chapters include tutorials intended to: 

1. Introduce you to some of the more commonly used statistical analyses. 

2. Illustrate how the unique features of STATGRAPHICS Centurion XVII facilitate the data 
analysis process. 

It is recommended that you explore the tutorials, since they will give you a good idea of how 
STATGRAPHICS Centurion XVII is best used when analyzing actual data. 

NOTE: a copy of this manual in PDF format is included with the program and may be accessed from 
the Help menu. In the PDF document, all of the graphs are in color. The data files and StatFolios 
referenced in the manual are also provided with the program. 

 
 
 

      Statpoint Technologies, Inc. 
      September, 2014 
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Getting Started  

Installing STATGRAPHICS Centurion XVII, launching the program, 
and creating a simple data file. 

1.1 Installation 
 
STATGRAPHICS Centurion XVII is distributed in two ways: over the Internet in a single file 
that is downloaded to your computer, and as a set of files on a DVD. To run the program, it 
must first be installed on your hard disk. As with most Windows programs, installation is 
extremely simple: 
 
Step 1: If you received the program on a DVD, insert the DVD into your DVD drive. After a 
few moments, the setup program should begin automatically. If it does not, open Windows 
Explorer and execute the file sgcinstall.exe in the root directory on the DVD.  
 
If you downloaded the program over the Internet, locate the file that you downloaded and 
double-click on it to begin the installation process. 
 
Step 2: A number of dialog boxes will then be displayed. If you are running the program from a 
DVD, the first dialog box asks you to specify the language or languages to be installed: 
 

Chapter  
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Figure 1-1. Language and Edition Selection Dialog Box 

Select a main language, the desired edition, and, if applicable, one or more additional languages. 
The main language will be used during installation and also as the default language when the 
program is first run. If you install additional languages, you can switch between languages while 
in the program by selecting Edit ð Preferences from the main menu. 
 
If you downloaded the program from the Internet, you will need to run a separate setup 
program for each language that you downloaded. 
 

NOTE: The 32-bit edition of Statgraphics Centurion will operate with any version of 
Windows, both 32-bit and 64-bit versions. The 64-bit edition of Statgraphics Centurion 
will only operate on computers using a 64-bit version of Windows. If you purchased a 
license, check your serial number. If the first character of the serial number is òSó, you 
must install the 32-bit edition. If the first character is òTó, you may install either edition. 
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NOTE: During the evaluation period users may access any of the languages available in 
STATGRAPHICS Centurion XVII.  Upon purchase you will be asked to designate 
your main and additional language (if any).  Please note that only those languages 
specified will be available for use in STATGRAPHICS Centurion XVII. 

 
Step 3: STATGRAPHICS Centurion XVII uses the standard Windows installer to install the 
program on your computer. The installer controls the installation through a series of dialog 
boxes. The first dialog box welcomes you to STATGRAPHICS Centurion XVII: 
 

  

Figure 1-2.  Welcome Dialog Box 

Just press the Next button. 
 

NOTE:  In order to install and activate STATGRAPHICS Centurion XVII you must 
have administrator rights to your computer.  In the event that you need to have a system 
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administrator present during the installation process, we highly recommend installing 
and activating the software while they are present. 

 
Step 4: The second dialog box displays the license agreement for the software: 
 

   

Figure 1-3.  License Agreement Dialog Box 

Read the license agreement carefully. If you accept the terms, click on the indicated radio button 
and press Next to continue. If you do not agree, press Cancel. If you do not agree with the terms, 
you may not use the program. 
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Step 5: The next dialog box is used to enter your name and organization:  
 

   

Figure 1-4.  Customer Information Dialog Box 
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Step 6: The next dialog box indicates the directory in which the program will be installed: 
 

   

Figure 1-5. Destination Folder Dialog Box 

By default, STATGRAPHICS Centurion XVII is installed in a subdirectory of Program Files named 
STATGRAPHICS Centurion XVII. If you are installing the program on a network server, install it in 
any location where all potential users have read access. Write access by users is not required. Consult 
the Readme.txt file from the STATGRAPHICS Centurion XVII CD or downloaded file for details on 
network installation. 
 
The dialog box also allows you to let everyone who uses your computer have access to the program, 
or you can limit access to just yourself. 
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Step 7: Follow the remaining instructions to complete the installation. When the installation is 
complete, a final dialog box will be displayed: 
 

   

Figure 1-6. Final Installation Dialog Box 

Click on Finish to complete the installation. 
 
 

1.2 Running the Program 
 
As part of the installation process, a shortcut to STATGRAPHICS Centurion XVII will be added to 
the Windows Start menu and also to your desktop. To launch the program: 
 
Step 1: Click on the shortcut that was added to your desktop, or press the Windows Start button 
in the bottom left corner of your screen and click on the Statgraphics icon. You may also select 
Programs Files ð Statgraphics - STATGRAPHICS Centurion XV II using Windows Explorer and 
click on the sgwin application icon to execute the program. 
 
Step 2: When STATGRAPHICS Centurion XVII loads, it will open up a new window. The first 
time you launch the program, the Welcome dialog box will be displayed: 
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Figure 1-7. Welcome Dialog Box 

You have two choices: 
 

1. To begin a 30-day trial before purchasing the program, push the Evaluate button. 
 

2. If you have already purchased the program and have received a serial number, press the 
Activate button. 

 
Beginning a 30-day trial period 
 
To begin a 30-day trial period, you must enter an activation code that is unique to your 
computer. When you press Evaluate for the first time, the following dialog box will be displayed: 
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Figure 1-8. Evaluation Period Activation Dialog Box 

The dialog box displays a 16-character Product Key that is unique to your computer. To begin 
your evaluation period, you must enter a matching Activation Code. To receive an Activation 
Code, press either of the two buttons under Step 2: 
 

1. The button labeled 1. Press Here automatically sends a message to StatPoint Technologies 
over the Internet requesting an Activation Code. A web service will respond to that 
request immediately, sending the Activation Code to the e-mail address that you supply. 

 
2. The button labeled 2. Press Here accesses your default e-mail program, placing the 

information in a new e-mail that you can send to StatPoint. E-mail requests will be 
processed during normal business hours. 

 
To avoid delay, use the first method whenever possible.  
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Activating a licensed copy 
 
If you or your institution has purchased a license to use the program, push the Activate button. 
This will display the dialog box shown below: 
 

   

Figure 1-9. Licensed Copy Activation Dialog Box 

After you enter the required information, including your serial number, the dialog box will 
display a 16-character Product Key that is unique to your computer. To activate the license, you 
must enter a matching Activation Code. To receive an Activation Code, press either of the two 
buttons under Step 2: 
 



 

11/ Getting Started 

1. The button labeled 1. Press Here automatically sends a message to StatPoint Technologies 
over the Internet requesting an Activation Code. A web service will respond to that 
request immediately, sending the Activation Code to the e-mail address that you supply. 

 
2. The button labeled 2. Press Here accesses your default e-mail program, placing the 

information in a new e-mail that you can send to StatPoint. E-mail requests will be 
processed during normal business hours. 

 
To avoid delay, use the first method whenever possible.  
 

NOTE #1: Users who are activating copies obtained under an institutional site 
license should use the first method. Activation codes will only be sent to e-mail 
addresses issued by the institution that purchased the site license. Institutional IT 
personnel should advise users of this requirement. 

 
NOTE #2: For single-user and network licenses, method #1 attempts to match the 
e-mail address and serial number you enter with the information provided when the 
license was purchased. If Statpointõs license database does not contain a matching 
e-mail address (as when it contains the address of a purchasing agent), you should 
use method #2. 

 
Step 3: Once your request is processed, an e-mail will be sent to you containing the Activation 
Code. Enter the code in the field provided under Step 3 and press the Activate button. If the code 
matches your product key, you will see the following message: 
 

  

Figure 1-10. Activation Message if Successful 

Press OK to enter the main section of the program. 
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NOTE #1: If you are running Microsoft Vista, Windows 7 or Windows 8 when you 
double-click on the STATGRAPHICS icon on your desktop to start the program, 
activation may not be successful.  If this is the case, you must right-click with your 
mouse and select Run as Administrator from the list of options that appear. 

NOTE #2: If you later install STATGRAPHICS Centurion XVII on a different 
computer you will need to repeat the process of obtaining an activation code, as the 
product key is different on each computer. 

 
Step 4: The main STATGRAPHICS Centurion XVII window will then be created: 
 

 

Figure 1-11. Main STATGRAPHICS Window 

The sections that follow illustrate how to create a data file containing data from the 2000 United 
States Census. 
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1.3 Entering Data 
 
In order to analyze data in STATGRAPHICS Centurion XVII, it must be placed into the 
STATGRAPHICS DataBook. The DataBook consists of up to 26 datasheets, indicated by the 
letters A through Z, each containing a rectangular array of rows and columns: 
 

 

Figure 1-12. The STATGRAPHICS DataBook 

In a typical datasheet, each row contains information about an individual sample, case or 
observation, while each column represents a variable. 
 
For example, suppose you wished to use STATGRAPHICS Centurion XVII to analyze data 
from the 2000 United States Census. A small section of the results of that census is shown 
below: 
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State Population Median Age % Female Per Capita Income 

Alabama 4,447,100 35.8 51.7 $18,819 

Alaska 626,932 32.4 48.3 $22,660 

Arizona 5,130,632 34.2 50.1 $20,275 

Arkansas 2,673,400 36.0 51.2 $16,904 

California 33,871,648 33.3 50.2 $22,711 

Colorado 4,301,261 34.3 49.6 $24,049 

Figure 1-13. Data from the 2000 U.S. Census 

When entering this data into a STATGRAPHICS Centurion XVII datasheet, the information 
about each state would be placed into a different row. Five columns would be created to hold 
the names of the states and the census data. 
 
To enter data such as that shown above into STATGRAPHICS Centurion XVI I, you have two 
choices: 
 

1. Type the data directly into the STATGRAPHICS Centurion XVII DataBook. 
 

2. Enter the data into another program such as Excel and then read or copy it into 
STATGRAPHICS Centurion XVII. 

 
In this section, weõll take the first approach. To begin, double-click on the header of the first 
column where the column name Col_1 appears. This will display a dialog box that you can use to 
change important properties of that column: 
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Figure 1-14. Dialog Box Used to Define Columns 

Each column in a STATGRAPHICS Centurion XVI I datasheet has a name, comment, and type 
associated with it: 
 

¶ Nameð Give each column a unique name containing from 1 to 32 characters. These names 
are used by the program to identify the variables to be analyzed when a statistical 
procedure is selected. They also serve as default labels on most graphs. Names may contain 
any characters and are not case sensitive. Spaces are permitted. The program will display an 
error message if you try to use the same name for more than one column in a datasheet, 
although columns in different datasheets may have identical names. 

 

¶ Comment ð Enter a comment identifying the data in the column. Comments may have up to 
64 characters and are optional. If entered, they appear in the second line of the column 
header. 

 

¶ Type ð Specify the type of data to be entered in the column. In this case, the first column 
containing state names must be set to Character. The other columns may be left as Numeric 
or set to Integer or Fixed Decimal if you want to restrict the type of data that may be entered. 
For detailed information on column types, see Chapter 2. 

 
After defining each column, press OK. Create five columns as shown below: 
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Figure 1-15. STATGRAPHICS Centurion XVI I Data Sheet with Column Names 

Now enter the data as you would in any spreadsheet, using the arrow keys to move from cell to 
cell. DO NOT  enter commas when entering large numbers. When done, the datasheet should 
have the following appearance: 
 

  

Figure 1-16. STATGRAPHICS Centurion XVI I Data Sheet after Entering 6 Rows of Data 

Finally, you need to save the data file.  Choose File ð Save ð Save Data File from the main menu.  
Select a file name in which to save the data: 
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Figure 1-17. Save Data File Selection Dialog Box 

Data files in STATGRAPHICS Centurion XVII are saved on disk by default with an extension 
of .sgd, which stores the data in XML format.  When saving the file, you may change the setting 
3in the Save as type field to a different file format if desired. 
 

1.4 Reading a Saved Data File 
 
Once the data have been entered into the datasheet, it is ready for analysis. To make the example 
more interesting, letõs retrieve the census data for all 50 states and the District of Columbia, 
which is provided with STATGRAPHICS Centurion XVII in a file named census2000.sgd. To 
open that data file, select File ð Open ð Open Data Source from the top menu. You will first be 
asked to specify the location of the data you wish to access: 
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Figure 1-18. Open Data Source Dialog Box 

The default selection is correct in this case. Next, select the name of the file containing the data: 
 

 

Figure 1-19. Open Data File Dialog Box 

The sample file is located in the default data directory (usually c:\ Program 
Files\ Statgraphics\ STATGRAPHICS Centurion XVII\ Data). Opening the file loads the full 51 
rows of data into the datasheet: 
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Figure 1-20. Datasheet Showing Contents of Census2000.sgd File 

 
 

1.5 Analyzing the Data 
 
Once the data have been loaded into the STATGRAPHICS Centurion XVII DataBook, any of 
the more than 220 statistical procedures may be accessed any of several ways: 
 

1. By selecting the desired procedure from the main menu. 
 

2. By pressing one of the shortcut buttons on the toolbar. 
 

3. By invoking the StatWizard by pressing the button on the toolbar displaying a wizardõs 
cap. 
 

Letõs begin by summarizing the variability in per capita income amongst the states. The best 
procedure for summarizing a single column of numeric data is the One-Variable Analysis 
procedure. This procedure calculates summary statistics such as the sample mean and standard 
deviation. It also creates several plots, including a histogram and box-and-whisker plot.  
 



 

20/ Getting Started 

The location of the One-Variable Analysis procedure depends on the menu you are using: 
 

1. Classic menu: Select Describe ð Numeric Data ð One-Variable Analysis. 
 
2. Six-Sigma menu: Select Analyze ð Variable Data ð One-Variable Analysis. 

 
Like all statistical procedures, the One-Variable Analysis begins by displaying a data input dialog 
box: 
 

  

Figure 1-21. One-Variable Analysis Data Input Dialog Box 

The list box at the left displays the names of all columns in the datasheets that contain data. To 
analyze the data in the Per Capita Income column, click on its name and then click on the button with 
the black arrow alongside the Data field.  This places the name of the column containing the income 
data into the Data field. Leave the Select field blank (it is used only when you want to analyze a subset 
of the rows in the datasheet instead of all the rows). 
 
When OK is pressed, the Tables and Graphs dialog box appears. This dialog box shows the tables and 
graphs that are available for the One Variable Analysis procedure. For now, the default settings will be 
acceptable:  
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Figure 1-22. Tables and Graphs Dialog Box 

When OK is pressed again, a new analysis window will be created: 
 

 

Figure 1-23. One-Variable Analysis Window 
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The window contains 4 òpanesó, divided by movable splitter bars. The two panes on the left 
display tabular output, while the two panes on the right display graphical output.  If you double-
click in the bottom left pane, the table of summary statistics will be maximized: 
 

  

Figure 1-24. Maximized Summary Statistics Pane 

Several interesting statistics are given in the table. Of the n = 51 states plus D.C., per capita 
income ranges between $15,853 and $28,766. The average per capita income is $20,934.50. 
 
Beneath the table is the output of the StatAdvisor, which gives a short interpretation of the 
results. In this case, the StatAdvisor concentrates on the two highlighted statistics, which 
measure the skewness and kurtosis in the data. As explained by the StatAdvisor, data that come 
from a normal or Gaussian distribution should yield standardized skewness and standardized 
kurtosis values between ð2 and +2. In this case, both statistics are within that range, indicating 
that a bell-shaped normal curve is a reasonable model for the observations, although the 
skewness is very close to being statistically significant. 
 
Double-clicking on the summary statistics table again will restore the original split display. 
Double clicking on the bottom right pane then maximizes the box-and-whisker plot: 
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Figure 1-25. Maximized Box-and-Whisker Plot Pane 

The box-and-whisker plot, invented by John Tukey, provides a 5-number summary of a data 
sample. The central box covers the middle half of the data, extending from the lower quartile to 
the upper quartile. The lines extending above and below the box (the whiskers) show the 
location of the smallest and largest data values. The median of the data is indicated by the 
vertical line within the box, while the plus sign (+) shows the location of the sample mean. The 
fact that the upper whisker is slightly longer than the lower, while the mean is somewhat greater 
than the median, is indicative of positive skewness in the data. 
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1.6 Using the Analysis Toolbar 
When an analysis window such as the One-Variable Analysis is first displayed, only some of the 
available tables and graphs are included. To display additional output, you must push the 
appropriate button on the Analysis Toolbar, which is displayed immediately above the analysis 
title: 
 

 

Figure 1-26. The Analysis Toolbar 

The buttons on the analysis toolbar are very important. The actions of the eight leftmost buttons 
are summarized below: 
 

 Name Function 

 
Input dialog Displays the data input dialog box so that the selected data 

column(s) may be changed. 

  
Analysis options Selects options that apply to all tables and graphs in the 

current analysis. 

  
Tables and graphs Displays a list of other tables and graphs that may be 

created. 

 
Save results Allows calculated statistics to be saved to columns of a 

datasheet. 

  
Pane options Selects options that apply only to the currently maximized 

table or graph. 

  
Tabular options Allows you to change the width of tables, the number of 

significant digits, and other options for text output. 

  
Graphics options Allows you to change the titles, scaling, and other features 

of the currently maximized graph. 

 
Save to logfile Saves the visible tables and graphs in the StatLog. 

Figure 1-27. Important Buttons on the Analysis Toolbar 

Additional buttons to the right allow other actions when a graph is maximized, as explained in 
Chapter 5.  
 

For example, if the Tables and Graphs button   is pressed, a dialog box will be displayed listing 
other graphs available in the One-Variable Analysis procedure: 
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Figure 1-28. List of Available Tables and Graphs 

Checking the box next to Frequency Histogram and pressing OK adds a third pane to the right-
hand side of the analysis window: 
 

   

Figure 1-29. One-Variable Analysis Window with Added Frequency Histogram 

If you double-click on the histogram to maximize it and then press the Pane options button, a 
dialog box is displayed with options specific to the histogram: 
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Figure 1-30. Frequency Histogram Pane Options Dialog Box 

Using this box, the number of bars in the histogram can be changed, as well as the range that 
they cover. If Number of Classes is set to 15 and the OK button is pressed, the histogram will 
change to reflect the new selection:  
 

  

Figure 1-31. Frequency Histogram After Changing the Number of Classes 
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You may also change the fill pattern and/or color of the bars in the histogram by pressing the 
Graphics options button. This displays a tabbed dialog box that allows you to change most features 
of the graph. If you click on the Fill tab, the following will be displayed: 
 

  

Figure 1-32. Graphics Options Tabbed Dialog Box 

Clicking on radio button #1 and then selecting a new Fill Type or Color will change the bars in 
the histogram. 
 
NOTE: The operations of many of the buttons on the analysis toolbar can also be accessed by 
clicking the alternate mouse button in the pane containing a table or graph. This displays a 
popup menu listing the available operations. 
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1.7 Disseminating the Results 
Once an analysis has been performed, the results can be disseminated in various ways. These 
include: 
 

Action Method 

Print the output. Press the printer button on the main 
toolbar to print all tables and graphs, 
or click on a single pane with the 
alternate mouse button and select 
Print from the popup menu to print a 
single table or graph. 

Publish the output for viewing in a 
web browser. 

Select StatPublish from the File menu. 
A dialog box will be displayed for 
you to specify the location of the 
HTML output. 

Copy the output to another 
application. 

Click on the table or graph to be 
copied and select Copy from the Edit 
menu. Then activate the other 
application and select Edit ð Paste. 

Save the analysis in a report. Press the alternate mouse button and 
select Copy Analysis to StatReporter. 
The StatReporter, described in 
Chapter 7, can be saved as an RTF 
file for import into programs such as 
Microsoft Word. 

Save a graph in an image file. Maximize the graph to be saved. 
Then select Save Graph from the File 
menu. 

Figure 1-33. Methods for Disseminating Analysis Results 

Each of these operations is described in later chapters. 
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1.8 Saving Your Work 
You can save the current STATGRAPHICS Centurion XVII session at any time by selecting Save 
StatFolio from the File menu and entering a file name: 
  

 

Figure 1-34. Dialog Box for Saving StatFolio 

A StatFolio consists of instructions on how to create each of the analyses in your current 
session, with pointers to the files or databases containing your data. If you reload the StatFolio at 
a later date, it will automatically reread the data and recreate the analyses. Any options you have 
selected for the analyses will be retained. 
 
NOTE #1: If the data in the data sources change between the time a StatFolio is saved and the 
time it is reloaded, the analyses will change to reflect the new values. This provides a simple 
method for rerunning analyses that need to be repeated on a periodic basis without having to 
recreate them. 
NOTE #2: The data and the StatFolio are usually stored in different files. If you need to move a 
StatFolio from one computer to another, be sure to move the data file(s) as well. 
NOTE #3: If the data are not saved before saving the StatFolio, it will be stored in the StatFolio 
file. 
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1.9 Using the StatLog 
STATGRAPHICS Centurion XVII contains a session log that may be used to track the opening and 
closing of files. Output generated by the statistical analyses may also be automatically copied to the log 
if desired. 
 
The StatLog appears in a separate window that may be selected from the navigation bar: 
 

 

Figure 1-35. StatLog Output Window 

It shows information such as when the session began, what data were loaded, and what analyses 
were performed. The current contents of the StatLog may be saved at any time by pressing the 
right mouse button and selecting Save StatLog As from the popup menu. The StatLog is saved as 
an RTF (Rich Text Format) file which may be read by applications such as Microsoft Word. 
 
To change the information that is saved in the StatLog, select Edit ð Preferences from the main 
menu. The General tab of the Preferences dialog box contains radio buttons that control what is 
saved in the StatLog: 
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Figure 1-36. Preferences Dialog Box Settings for Session Log 

Selecting Full audit trail will save everything to the session log. Selecting Custom output lets you 
select the output that is saved. 
 
The contents of any analysis window may also be appended to the bottom of the StatLog at any 

time by putting the focus on that window and pressing the StatLog button  on the analysis 
toolbar. 
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Data Management  

Accessing data from files and databases, transforming data values, generating 
patterned data. 

In order to analyze data in STATGRAPHICS Centurion XVII, it must first be placed in the 
STATGRAPHICS Centurion XVI I DataBook. The DataBook is a tabbed window, consisting of 
up to 26 datasheets. A datasheet is a rectangular array of rows and columns. Each column in a 
datasheet represents a variable. Each row represents a case or observation. For example, the 
datasheet below contains information on a number of different makes and models of 
automobiles. 
 

  

Figure 2-1. Sample Datasheet 

Chapter  

2 
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This chapter describes everything you need to know about data and STATGRAPHICS 
Centurion XVI I, including how to access it, how to manipulate it, and how to use it in statistical 
analyses. 
 

2.1 The DataBook 
Each column in the STATGRAPHICS Centurion XVII datasheet represents a different variable. 
Variables are usually attributes or measurements associated with the items that define the rows 
of the datasheet. For example, in the 93cars datasheet, there is a column identifying the make of 
each automobile, a column identifying its type, columns containing the recorded miles per gallon 
in city and highway driving, columns containing the automobileõs length, height and weight, and 
similar information. Each column has a name and type associated with it. The name is used to 
identify the data to use in a statistical analysis. The type affects how it will be analyzed. Also 
associated with each column is an optional comment, which is used to provide additional 
information about the contents of a column. NOTE: the data were obtained from the Journal of 
Statistical Education Data Archive (www.amstat.org/publications/jse/jse_data_archive.html) 
and are used by permission. 
 
To display or change the properties of any column in a datasheet, double-click on the column 
name to display the Modify Column dialog box: 
 

  

Figure 2-2. Dialog Box Used to Modify Column Properties 

You may specify: 

http://www.amstat.org/publications/jse/jse_data_archive.html
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1. Name: from 1 to 32 characters. When performing statistical analyses, columns are 

identified using these names. Each column in a datasheet must have a unique name, 
though columns in different datasheets may have the same name. Names may include 
any character, including spaces. Variable names are not case sensitive. 
  

2. Comment: from 0 to 64 characters, providing additional information about the contents 
of the column. 

 
3. Type: the type of data permitted in the column. The following types may be specified: 

 

Type Contents Example 

Numeric Any valid number. 3.14 

Character An alphanumeric string Chevrolet 

Integer An integer number 105 

Date Month, day and year 4/30/05 

Month Month and year 4/05 

Quarter Quarter and year Q2/05 

Time (HH:MM) Hour and minute 3:15 

Time (HH:MM:SS) Hour, minute and second 3:15:53 

Date-Time 
(HH:MM) 

Month, day, year, hour and 
minute 

4/30/05 3:15 

Date-Time 
(HH:MM:SS) 

Month, day, year, hour, 
minutes and second 

4/30/05 3:15:53 

Fixed Decimal Number with 1 to 9 places 34.10 

Percentage Number entered as a 
percentage 

95% 

Formula Calculated from other columns MPG City/MPG Highway 

Figure 2-3. Column Types 

 
4. Value Labels: labels that may be used to replace numeric values in output tables and 

graphs. To reduce typing errors when entering data, numeric values (such as 1, 2, 3, é) 
may be entered into a data column and replaced by labels when results are displayed. 
When the Value Labels button is pushed, the dialog box shown below is displayed: 
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Figure 2-4. Dialog Box for Specifying Value Labels 

 
The dialog box above defines 5 labels that might be used for entering the results of a 
survey. Numbers between 1 and 5 would be entered in the datasheet, but labels such as 
òDisagree stronglyó would appear in place of those numbers in tables and graphs. 

 
When entering data into a datasheet, the data must conform to the type of column in which it is 
entered. For example, attempting to type a name into a numeric column will result in it being 
rejected. When entering data, the format of the data must also match your current Windows 
settings. In particular, STATGRAPHICS Centurion XVII honors the current Windows settings 
for: 
 

1. Decimal separator for numeric values 
2. Time format and time separator for times 
3. Short date format and date separator for dates 

 
To check the settings of your computer, access the Windows Control Panel. 
 
When entering a date, you must use the format specified on the Edit - Preferences dialog box, 
either 4-digits years (as in 4/30/2005) or 2-digit years (as in 4/30/05). If a 2-digit year is used, it 
is assumed to fall within the years 1950 through 2049.  
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More information about formula columns may be found in a later section of this chapter titled 
Manipulating Data. 
 

2.2 Accessing Data 
Chapter 1 showed how data can be entered into a datasheet by hand. More often, users will 
access data that already exists in another file or application. There are 3 basic ways of putting 
existing data into a STATGRAPHICS Centurion XVII datasheet: 
 

1. Read an existing data file: If the data have previously been entered into a file, you can 
read it into the datasheet by selecting File ð Open ð Open Data Source. This allows you to 
read data stored in various file formats, including Excel files, delimited ASCII text files, 
XML files, STATGRAPHICS files, and files from other statistical packages. 

 
2. Copy and paste using the Windows clipboard: If you have the data loaded into a 

program such as Excel, you can easily copy it to the Windows clipboard and then paste it 
into STATGRAPHICS Centurion XVII by selecting Edit ð Paste. 

 
3. Issue a SQL query to retrieve it from a database: If the data resides in an ODBC-

compatible database, such as Oracle or Microsoft Access, it can be retrieved by selecting 
File ð Open ð Open Data Source and then selecting either ODBC Query to use the query 
wizard or Manual SQL Query to enter a predefined query.  

 

2.2.1 Reading Data from a STATGRAPHICS Centurion Data File 

To read data that have already been saved in a STATGRAPHICS Centurion data file, select any 
of the datasheets in the DataBook by clicking on its tab. Then select File ð Open ð Open Data 
Source and specify STATGRAPHICS Data File on the dialog box shown below: 
 

  

Figure 2-5. Open Data Source Dialog Box 
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After pressing OK, select the desired STATGRAPHICS file: 
 

   

Figure 2-6. Selecting a STATGRAPHICS Data File 

You can read data files from STATGRAPHICS Centurion XVII or any previous version of 
STATGRAPHICS, including STATGRAPHICS Plus. The data in the file will replace the 
contents of the currently selected datasheet. 

2.2.2 Reading Data from an Excel, ASCII, XML, or Other External Data File 

To read data that have been saved in a data file created by another application, select any of the 
datasheets in the DataBook by clicking on its tab. Then select File ð Open ð Open Data Source and 
specify External Data File on the dialog box shown below: 
 

  

Figure 2-7. Open Data Source Dialog Box 
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After pressing OK, a dialog box will be displayed on which to specify the file to be imported and 
other relevant information: 
 

  

Figure 2-8. Selecting an External Data File 

The fields on this dialog box include: 
 

1. Input file type ð type of file to be imported. STATGRAPHICS Centurion XVII can 
import data from many other applications, including Excel, Matlab, Minitab, JMP, SPSS, 
SAS, and many other statistical packages. 

 
2. File name ð name of the file to be imported. Press the BROWSE button to select the 

desired file. 
 

3. Worksheet ð name of the worksheet to import (if relevant).  Only one sheet may be read 
at a time. 

 
4. Column widths ð width of each column, separated by commas (for formatted ASCII 

files only). 
 

5. Delimiter ð column delimiter (for delimited ASCII files only). 
 

6. Rows - the range of rows within the worksheet that will be read. This range includes the 
variable names and comments, if present. 
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7. Header - information contained in the first 2 rows of the specified range (for 
spreadsheet programs such as Excel). The two rows immediately above the data to be 
read may contain column names and/or comments. If names are not contained in the 
file, then default names will be generated. 

 
8. Missing value identifier - any special symbol used in the external file to indicate 

missing data, such as NA . Cells containing the specified value will be converted to empty 
cells when placed in the STATGRAPHICS Centurion XVII datasheet. 

 
When OK is pressed, the data from the external file will be read into STATGRAPHICS 
Centurion XVI I. Each column will be scanned and an appropriate column type assigned to it. 
The data are then ready to be analyzed. 
 

2.2.3 Transferring Data Using Copy and Paste 

The easiest way to transfer data from another application to STATGRAPHICS Centurion XVII 
is often via the Windows clipboard. For example, if data reside in an Excel file, Excel may be 
started and the data copied to the clipboard by selecting the desired data within Excel and then 
choosing Copy from the Excel Edit menu. Upon returning to STATGRAPHICS, the data may be 
pasted directly into a STATGRAPHICS Centurion XVII datasheet by selecting Paste from the 
STATGRAPHICS Edit menu. When data is pasted into a column of a datasheet, 
STATGRAPHICS Centurion XVII automatically scans the data and selects an appropriate type 
for the column. 
 
When copying and pasting data, column names and comments may also be transferred. Include 
the column names and comments in Excel when copying the data to the clipboard. On the 
STATGRAPHICS Centurion XVII side, click in the header row of the STATGRAPHICS 
Centurion XVII datasheet before selecting Paste. The information at the top of the clipboard will 
then be pasted into the header row(s). 
 

2.2.4 Querying an ODBC Database 

STATGRAPHICS Centurion XVII also allows you to read data from an Oracle, Access, or 
other database using ODBC. To access data from a database, first select File ð Open ð Open Data 
Source. Then select Query Database from the initial dialog box (if you wish to use the query wizard) 
or Manual SQL Query if you have a predefined query that you wish to enter. To use the query 
wizard, complete the dialog box as shown below: 
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Figure 2-9. Open Data Source Dialog Box 

A sequence of additional dialog boxes will be displayed on which you: 
 

1. Select the name of the database to be read. 
 
2. Select the fields to be transferred. 

 
3. Specify a filter to limit the records that are retrieved. 

 
4. Specify a sort order for the results. 

 
A SQL query is then constructed and the results placed in the active STATGRAPHICS 
Centurion XVII datasheet. Detailed information on constructing ODBC queries may be found 
in the PDF document titled Data Files and StatLink. 

 
2.3 Manipulating Data 
Once data have been placed into a STATGRAPHICS Centurion XVI I datasheet, it can be 
manipulated in several important ways: 
 

1. The data may be copied and pasted into other locations. 
 
2. Additional columns may be created from existing columns. 

 
3. Data may be transformed using an algebraic expression or mathematical function. 

 
4. The datasheet may be sorted according to one or more columns. 

 
5. Data values may be recoded to form groups or for other reasons. 
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6. Data extending over multiple columns can be rearranged into a single column if required 
by a statistical procedure. 

 
These important operations are described below. 
 

2.3.1 Copying and Pasting Data 

The STATGRAPHICS Centurion XVII datasheet supports many typical spreadsheet operations, 
including cut, copy, paste, insert, and delete. The one important fact to remember when using these 
operations is that every column has a specified type. If you inadvertently paste character data 
into a numeric column, STATGRAPHICS Centurion XVII will change the type of that column 
to accommodate the new data. If you ever have any doubt about a columnõs type, click on the 
column header to display the Modify Column dialog box. You can change the type of the column 
using that dialog box. 
 

2.3.2 Creating New Variables from Existing Columns 

STATGRAPHICS Centurion XVII has a wide array of operators to assist in performing 
mathematical calculations. One of the most important uses of these operators in data analysis is 
to create new variables based on existing columns. In STATGRAPHICS Centurion XVII, new 
variables may be created: 
 

1. òOn-the-flyó directly within the data fields on data input dialog boxes, without saving the 
variable in the datasheet. 

 
2. By creating a new column in any of the 26 datasheets in the DataBook. 

 
For example, suppose information was desired about the ratio of miles per gallon in city driving 
versus miles per gallon in highway driving for each automobile in the 93cars data file. That file 
contains 2 separate columns, one named MPG City and one named MPG Highway. To summarize 
the distribution of the ratios, you could select the One-Variable Analysis procedure and specify the 
ratio directly in the Data field of the data input dialog box: 
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Figure 2-10. Creating a Transformation òOn-The-Flyó 

When OK is pressed, an analysis will be generated for 100 times the ratio, without ever changing 
the data in the datasheet: 
 

  

Figure 2-11. One-Variable Analysis of Transformed Data 

The average ratio is approximately 76.3%, ranging from a low of 64.0% to a high of 93.9%. The 
ability to do analyses without modifying the datasheets is very important in facilitating the 
exploration of data. 
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If desired, a new column could be created in a datasheet containing the transformed values. For 
example, you could return to the window containing the 93cars data and double-click on the 
column header labeled Col_27. The Modify Column dialog box could then be used to define a new 
variable of type formula with the desired transformation: 
 

  

Figure 2-12. Creating a Formula Column 

This will create a new column whose values are calculated from the original two columns 
containing the miles per gallon data. Formula columns are displayed in the datasheet using a gray 
scale, since they are automatically calculated from other columns: 
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Figure 2-13. Appearance of a Formula Column in a Datasheet 

If the values in the MPG City or MPG Highway columns change, MPG Ratio will be automatically 
recalculated to reflect those changes. 
 

NOTE: Recalculation of formula columns does not normally occur until the data in 
those columns is needed for a calculation or is saved or printed.  You can specify a 
recalculation to occur immediately by selecting Update Formulas from the Edit menu. 

2.3.3 Transforming Data 

STATGRAPHICS Centurion XVI I also contains a large number of mathematical functions that 
may be used to transform existing data. As when creating new variables, transformations may be 
done either directly within fields of a data input dialog box or by creating new columns in a 
datasheet. 
 
For example, suppose it was desired to plot the miles per gallon that an automobile obtained 
versus the natural logarithm of vehicle weight. Selecting the X-Y Plot procedure from the main 
menu displays the following data input dialog box: 
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Figure 2-14. Transforming Data on a Data Input Dialog Box 

Instead of typing the name of a column in a data field, you may type a STATGRAPHICS 
Centurion expression. STATGRAPHICS Centurion expressions are formulas that operate on 
data using algebraic symbols and special operators. A wide variety of operators are available, as 
described in the PDF document titled STATGRAPHICS Operators. The table below shows 
commonly used operators: 
 

Operator Use Example 

+ Addition X+100 

- Subtraction X-100 

/  Division X/100 

* Multiplication X*100 

^ Exponentiation X^2 

ABS Absolute value ABS(X) 

AVG Average AVG(X) 

DIFF Backward differencing DIFF(X) 

EXP Exponential function EXP(10) 

LAG Lag by k periods LAG(X,k) 

LOG Natural logarithm LOG(X) 

LOG10 Log base 10 LOG10(X) 

MAX Maximum MAX(X) 

MIN  Minimum MIN(X) 

SD Standard deviation SD(X) 

SQRT Square root SQRT(X) 

STANDARDIZE Conversion to Z-scores STANDARDIZE(X) 

Figure 2-15. Commonly Used STATGRAPHICS Operators 
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When constructing a STATGRAPHICS Centurion expression, multiple operators may be 
combined using normal algebraic precedence rules. For example, the following expression 
converts each value in the column named Weight to a fraction equal to the distance between the 
minimum and maximum values amongst all of the automobiles: 
 
 ( Weight ð MIN(Weight) ) / ( MAX(Weight) - MIN(Weight) ) 
 
The parentheses are necessary to insure that the subtractions are done before the division. 
Expressions are not case sensitive, nor is the inclusion of blank spaces relevant. 
 
Every data input dialog box includes a button labeled Transform. This button may be used to help 
create STATGRAPHICS Centurion expressions, if you do not remember which operators to 
use. If you place the cursor in a data field and then press Transform, a dialog box similar to that 
shown below will be displayed: 
 

  

Figure 2-16. Dialog Box Displayed by the Transform Button 

Along the right is a list of all STATGRAPHICS Centurion operators, with an indication of the 
number of arguments that must be supplied. Clicking on an operator name places it in the 
Expression field. After you replace the question marks with column names or numbers, you may 
press the Display button to see the first several values generated by the expression, or press the 
OK button to have the expression entered into the data input dialog box. 
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NOTE: You do not need to use the Transform button if you would rather type the 
expression yourself on the data input dialog box. 

Once a transformation has been specified on the data input dialog box, that transformation will 
be used when the procedure is run: 
 

  

Figure 2-17. X-Y Plot Procedure Using Transformed values of Weight 

STATGRAPHICS Centurion operators may also be used when creating formula columns, similar 
to the illustration in the preceding section. 
 

2.3.4 Sorting Data 

The contents of a datasheet may be sorted by highlighting the column or columns to be used to 
define the sort order and then selecting Sort Data from the Edit menu. For example, to sort the 
data in the 93cars file according to miles per gallon, highlight the columns named MPG City and 
MPG Highway and then select Sort Data. The following dialog box will be displayed: 
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Figure 2-18. Sort Options Dialog Box 

You may specify either one or two columns on which to base the sort, as well the sort order. 
Sorting by MPG City and then MPG Highway sorts first by miles per gallon in city driving and 
then, for automobiles with the same value of MPG City, by miles per gallon in highway driving: 
 

  

Figure 2-19. 93cars.sgd File after Sorting 
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NOTE: The statistical procedures do not require you to sort the data before using them, 
since they will automatically sort the data if necessary. Also, the data file on disk is not 
changed when you perform a sort unless you resave the data. Sorting only affects the 
order in which the rows are displayed in the datasheet. 

2.3.5 Recoding Data 

It is sometimes convenient to recode data, either by grouping it into similar groups or by 
assigning new labels. To recode a column of data, first click on the header of the column to be 
recoded. Then select Recode Data from the Edit menu. The following dialog box will be displayed: 
 

  

Figure 2-20. Dialog Box for Recoding Data 

For example, the column named Domestic in the 93cars file contains a 1 for each car made by a 
U.S. automaker and a 0 for all other cars.  To change all 0õs in the column to òForeignó and all 
1õs to òU.S.ó, the dialog box above could be used. Up to 7 ranges of values may be specified at 
one time for recoding. 
 
The PDF document titled Edit Menu has a detailed discussion of two recoding examples. 
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2.3.6 Combining Multiple Columns 

Many statistical procedures in STATGRAPHICS Centurion XVII expect the data to be analyzed 
to be in a single column. Sometimes data is not arranged in such a format. As a simple example, 
suppose you have a sample of 12 observations, arranged into 4 columns as follows: 
 

 

Figure 2-21. Sample Data in Multiple Columns 

To place this data in a single column, multiple copy and paste operations could be performed. A 
simpler solution is to use the Combine columns procedure, found under Edit on the main menu. 
This procedure first presents a data input dialog box requesting the names of the columns 
containing the data: 
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Figure 2-22. Data Input Dialog Box for Combine Columns 

It contains the following fields: 
 

1. Data ð columns to be combined. 
 

2. Select ð standard subset selection field to choose a subset of the rows. 
 

3. Put in Datasheet ð target data sheet for the combined data. 
 

4. Column Order ð whether to stack the data by column (one column after the other) 
or by row. 

 
5. Create column with row numbers ð whether to create a second column identifying 

the original row containing each data value. 
 

6. Create column with identifiers ð whether to create a second column identifying 
the original column containing each data value. 
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7. Remove missing values ð whether to skip all blank cells rather than leaving a 
placeholder. 

 
When OK is pressed, the data are combined into a single column as shown below: 
 

  

Figure 2-23. Data Combined into Single Column 

 
 

2.4 Generating Data 
STATGRAPHICS Centurion XVII has the ability to generate data and place it in columns of a 
datasheet. This section describes two important examples: 
 

1. Generating data with simple patterns. 
 
2. Generating random numbers. 
 

2.4.1 Generating Patterned Data 

Several procedures in STATGRAPHICS Centurion XVII, particularly those that perform an 
analysis of variance, expect the data to be analyzed to be placed into a single column of the 
datasheet, together with one or more code columns identifying the explanatory factors. For 
example, consider the data in the following two-way table: 
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Blend Treatment 1 Treatment 2 Treatment 3 

1 75 82 91 

2 78 85 93 

3 77 84 92 

4 75 85 96 

 
To analyze this data using the Multifactor ANOVA procedure, it needs to be placed into a 
datasheet in the following format: 
 

  

Figure 2-24. Desired Data Structure 

The first two columns indicate the levels of the factors corresponding to each data value. The 
third column contains all of the observations.  
 
To create such a file, the easiest solution is often to type in the first two columns. However, 
since the columns follow simple patterns, you could generate them instead using special 
STATGRAPHICS Centurion operators. For example, the blend numbers can be generated by 
clicking on the column #1 header and then selecting Generate Data from the Edit menu. This 
displays the following dialog box, into which an expression has been entered: 
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Figure 2-25. Generating Blend Numbers 

The Generate Data option evaluates a STATGRAPHICS Centurion expression and places the 
result into the selected column. In the expression shown above, two important operators are 
used: 
 

COUNT(from, to, by) ð generates values beginning at from and ending at to, at intervals 
equal to by. COUNT(1,4,1) thus generates the integers 1, 2, 3, and 4. 
 
REP(X, repetitions) ð repeats each value in X repetitions times, in groups. In this case, each 
integer between 1 and 4 is repeated 3 times. 

 
The treatment numbers can be generated in a similar manner by clicking on the column #2 
header, selecting Generate Data from the Edit menu, and entering the following: 
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Figure 2-26. Generating Treatment Numbers 

This expression uses an additional operator: 
 

RESHAPE(X, size) ð repeats the values in X in a circular fashion until size values have 
been generated. In this case, the sequence 1, 2, 3 is repeated 4 times. 

 
These pattern generators can be helpful when the data file to be created is large. 
 

2.4.2 Generating Random Numbers 

Random numbers may be generated in STATGRAPHICS Centurion XVII in three ways: 
 

1. If the numbers come from an exponential, gamma, lognormal, normal, uniform, or 
Weibull distribution, they may be generated within a datasheet by clicking on a column 
header, selecting Generate Data from the Edit menu, and entering the appropriate 
STATGRAPHICS Centurion expression.  

 
2. Random numbers may be generated from many distributions by selecting Monte Carlo 

Simulation ð Random Number Generation from the Tools menu. 
 

3. Random numbers may also be generated from within the Probability Distributions 
procedure. 

 
As an example, suppose 100 random numbers are desired from a normal distribution with a 
mean of 20 and a standard deviation equal to 2. Click on the header of an empty column in any 
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datasheet to select that column. Then select Generate Data from the Edit menu and complete the 
dialog box as shown below: 
 

  

Figure 2-27. Generating Random Numbers from a Normal Distribution 

The syntax of the RNORMAL operator is: 
 

RNORMAL(n, mu, sigma) ð generates n pseudo-random numbers from a normal 
distribution with mean mu and standard deviation sigma. 

 
Press OK to generate the random numbers and place them into the selected column. 
 
The syntax of the other random number generators is contained in the PDF document titled 
STATGRAPHICS Centurion Operators. 
 
 

2.5 DataBook Properties 
This chapter has described many important aspects of data handling within STATGRAPHICS 
Centurion XVII. In particular, it has shown how to read data from files and databases and how 
to manipulate that data once it has been placed in a STATGRAPHICS Centurion XVII 
datasheet. At any given time, the status of the datasheets may be displayed by activating the 
DataBook window and selecting DataBook Properties from the Edit menu or by selecting StatLink 
from the File menu: 
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Figure 2-28. DataBook Properties Dialog Box 

This dialog box shows the current source of the data within each datasheet. It can also be used 
to change the number of datasheets that are displayed in the DataBook. If desired, datasheets 
may be made read-only so that data in them cannot be changed inadvertently. It is also possible 
to poll the data source (reread it) at regular intervals and have the statistical procedures update 
automatically. These important features are described in Chapter 5. 




















































































































































































































































































































































































































































































































